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computer and can also be printed out using the print option from the File menu.

Send any comments on the Tapestry documentation or questions about the
Tapestry software to support@concept1.com.

Website - http://www.concept1.com

Technical Support  - support@concept1.com

You may freely copy and distribute copies of this documentation in electronic or
printed form, as long as you do not modify it or offer it for sale.
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0 Tapestry Checklist and Support

The Tapestry Version 1.1 release consists of the following files:

• Tapestry 1.1 (the executable programme)

•.The Tapestry documentation (this document)

• The Readme file.

• The Concept 1 Communications, Inc. Licence Agreement

• Tapestry Registration form.

• Tapestry Upgrade Policy

• Fresco Offer

The following are highly recommended for Tapestry users:

Quicktime 2.1
Sound Manager
Clipping Extension*
Drag/drop Manager*
Netscape NavigatorTM 2.0
Quicktime video plug-in for Netscape
GraphicConverter

*The clipping extension and drag/drop manager are not needed with recent
versions of System 7.

See the Concept 1 Website (http://www.concept1.com) for more information
on how to obtain them.
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1 Overview

Tapestry is an authoring and publishing tool for multimedia documents. It helps
you create documents in HTML, the language of the World Wide Web. You can
create HTML documents using Tapestry without ever knowing what HTML is, or
how to write HTML markup.

With Tapestry, you simply drag and drop pictures, sound and video into
documents to create multimedia. You can then create a network of multimedia
documents by dragging and dropping files (or URLs and bookmarks from
Netscape Navigator) onto marked up text to create links. Tapestry is the easiest,
and most efficient, tool for creating multimedia documents for the Web.

1.1 What is HTML?

HTML (HyperText Markup Language) adds tags to text  documents to turn them
into multimedia documents. For instance, the following paragraph illustrates
some marked up text in HTML.

<p>This paragraph begins with an open paragraph tag. The close
paragraph tag (optional) is shown at the end of the paragraph.</p>
<p>This paragraph contains a centred image, which is stored in the image
subdirectory. <center><IMG SRC="image/SittingBull"></p>

Tapestry creates this kind of markup for you, so you don't have to worry about
the details of creating tags.

1.2 How Does Tapestry handle HTML?

Tapestry handles a key subset of HTML.

Tapestry emphasizes ease of use and efficiency. Tapestry handles the most
important and frequently used HTML functions, including:

• adding images, video, sound, and background textures to documents
• adding links
• implementing basic formating operations (e.g., paragraphs, alignment,

text style)
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Tapestry also allows you to edit other HTML markup by hand, thereby giving
you access to a full range of HTML functionality. Editing HTML markup by
hand is explained in the “HTML Markup” section of this document.

1.3 Pointers to Useful Sites

When you create Web pages you are building/publishing something that can
potentially be viewed by millions of people around the world. Obviously you
want to do the best you can in terms of graphic design and presentation.
Fortunately, the Web contains many sites that provide good (and sometimes bad)
examples of how Web pages should look.

You can also find libraries of images and clip art on the Web.

We have constructed a list of interesting Web sites that you might want to review
as you go about preparing your Web pages. You can find these Web sites on the
Tapestry CD-ROM. Those of you who downloaded Tapestry directly from the
Concept 1 Website will find the list of interesting links on the Web site. Note that
due to the dynamic nature of the Web, some of the recommended links may be
broken when you try them. If you have problems with any of the links please
send email to support@concept1.com and we will update the list of interesting
sites accordingly. We would also be interested in any feedback on other
interesting Web sites that are not  included in our list.

2 Using links

2.1 What is a Link?

A link is a connection from one node of information (or document) to another.
The presence of a Link is indicated by an "anchor" in the document. An anchor is
a portion of the document that is highlighted in some way (e.g., underlined and
coloured in blue) to indicate that it represents a link. Technically, an anchor is a
visible indication that a link exists. Typically though, people don’t make a
distinction between the link that they see and the link that they follow. Thus we
will refer to links rather than anchors in the remainder of this User Guide.
If you click on a link while in a Web browser (such as Netscape NavigatorTM) then
you follow the connection to the node at the end of the link, which is then
displayed. Following links from one document to another is a standard way of
browsing or looking for information on the Web.
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2.2 What is Hypertext?

If a lot of documents are connected to each other by links, then the resulting
network of documents is called Hypertext. Multimedia uses hypertext linking (or
simply, hyperlinking). Thus HTML is called the Hypertext Markup Language
because it uses hyperlinking to create networks of documents connected by links.

2.3 Linking to a Local File

There are two kinds of links: links to local files and links to external files on the
Web. There are also different methods for making each type of link (via drag and
drop, the menu option, or the toolbar button).

Method A: Using Drag and Drop for Local Linking

1 . Highlight the text and/or images you want to use as the link (click and
drag with the mouse over the material that you want to highlight/select).

Screenshot 1 shows text being highlighted.

Screenshot 1
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2 . Find the File you want to link to (on the desktop or in a folder).

Screenshot 2 shows a file being dragged onto the highlighted region

Screenshot 2

3 . Drag the File onto the highlighted region. Do this by clicking on it and
moving the mouse (and the file icon) while holding the mouse button down.
Release the mouse button when the file icon is over the highlighted region.

Feedback: As you drag the file icon over to the anchor, you should see the
outline of the file moving across the screen.

You have now created the link.

Feedback: Listen for the sound telling you that the link has been created.

Screenshot 3 shows the link after the drag and drop operation is
completed.
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Screenshot 3

Method B: Using the Menu Option or Toolbar Button for Local
Linking

1 . Highlight the text and/or images you want to use for the link (this will
be the Anchor in the current document).

Screenshot 1 shows text being highlighted.

2 . Choose the "Link" menu item in the "Special" Menu.

This selection is shown in Screenshot 4

Alternatively, choose the “Link” toolbar icon.
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Screenshot 4

You will then see a dialog asking what kind of link you want.

3 . Choose “Internal”.

A file selection dialog will then appear that will ask you to find the file you
want to link to.

4 . Use the file selection dialog to move to the directory where the
document is, and select the document you want to link to.

You have now created the link.

Feedback: Listen for the sound telling you that the link has been created.

Screenshot 3 shows the result after the link has been added.

Now, if  you move the mouse cursor over the link anchor you will see the
location of the linked document in the file system displayed in red at the bottom
of the Tapestry window. Screenshot 5 shows the location of a linked document
being displayed.
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Screenshot 5

2.4 Linking to a File on the Internet

Tapestry is the only Web authoring tool that allows you to drag URLs (and
bookmarks) directly from Netscape Navigator into your Web page. Alternatively,
you can make an HTTP link using the menu option.

Method A: Using Drag and Drop for External Linking

1 . Highlight the text and/or images you want to use as the link (click and
drag with the mouse over the material that you want to highlight/select).

Screenshot 1 shows the result of this highlighting.

2 . Launch Netscape NavigatorTM (if it is not already open)

3 . Find a link (URL) you want to use

4 . Click and Drag the link out of the Netscape window onto the highlighted
text and/or images in the Tapestry window. This drag operation is shown
in Screenshot 6.
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Screenshot 6

5 . Release the mouse button when the link is on top of the highlighted
region.

Note: It is easy to tell when the dragged link is over the selection region,
because the highlight rectangle is displayed, as shown in Screenshot 6.

The external link has now been created, and it appears as in Screenshot 3.
If you now move the mouse cursor over the link, the URL (Uniform
Resource Locator) for the external link will be shown in red at the bottom
of the screen.

Dragging links out of Netscape Navigator may take a little practice. If you click
on the link but forget to hold the mouse button down you will end up going to the
page on the Web at the end of the link. If you click and hold the mouse button
down on the link for too long you will get a pop-up menu. In this case, simply
move the mouse off the link to get rid of the menu, then release the mouse button
and try again. Once you learn the timing, this operation is very simple. Click
down on the link to select it and then move the mouse off the link while holding
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the mouse button down. When you do this right, you will see a small outline
rectangle following the mouse as it moves away from the link. You will continue
to see this outline rectangle as you move the link (represented by the outline
rectangle) into the Tapestry window. When the outline rectangle is over the
highlighted text, a highlighted rectangular box will appear around the highlighted
text, as shown in screenshot 6.

Note: To drag a link over from Netscape Navigator into Tapestry you will need
to have both the link (URL) in Netscape and the highlighted text in Tapestry
visible. On a small screen, this may require you to move the windows around a
bit. With practice, this type of window management becomes easier. If you have a
very small screen, or find this kind of window management difficult, then you
can use the following alternative method:

1 .  Go to the URL (Web page) that you want as the link endpoint

2 .  Click and drag over the contents of the location box at the top of the
Netscape screen (select everything after the opening "http://") to select it

3 .  Copy the URL (e.g., with Command-C, or by choosing "copy" from the
Edit menu)

4 .  Select the "link" from the “Special” menu and choose the “HTTP”
option

5 .  Paste the desired URL into the link destination dialog (screenshot 7) that
appears.

Method B: Using the Menu Option or Toolbar Icon for External
Linking

1 . Highlight the text and/or images you want to use for the link (this will
be the Anchor in the current document).

Screenshot 1 shows the result of this highlighting.

2 .  Choose "Link" from the "Special" Menu.

Alternatively, choose the “Link” toolbar icon.

A dialog will appear that will ask you to choose the type of link. Choose
one of the five different external link types (http, ftp, gopher, mail to,
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news). Once you have chosen the link you should then type in the URL for
the file you want to link to, as shown in Screenshot 7. Note that the first
part of the URL (e.g., http://) is entered in for you already.

Screenshot 7
3 .  Click "OK"

You have created the link

Feedback:  The link is then indicated by underlined blue text, as
shown in Screenshot 3.

2.5 Linking to a Netscape Bookmark

Most people like to collect bookmarks of their favourite Web sites. With Netscape
Navigator you can build bookmarks into hierarchies. You can then drag and drop
your bookmarks directly into Tapestry documents. Going back through your
bookmarks to find a relevant site to refer to is generally much more efficient
than trying to browse through the Web for an interesting or relevant site. You'll
most likely get distracted by the sites you are visiting and forget about your main
task of creating a Web page.

Carry out the following steps to turn a Netscape bookmark into a Tapestry link:

1 . Select/highlight the text or content in the Tapestry document that you
want to create the link for.

2 . Open Netscape Navigator if it isn't already open.

3 . Go to the "Window" menu on the Netscape Menubar and select
"Bookmarks". A window will open showing you the hierarchical
organization of the Netscape bookmarks.
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4 . Choose the bookmark that you want to link to. Click on the bookmark
and drag it over to the selected content in the Tapestry document. You will
see a highlight box around the selected content.

5 . Release the mouse button while the highlight box is visible.

6 . The link to the bookmark is created.

Hint: Building Web pages is much easier when you have organized the material
that you want to link to. If you are linking to files on the hard drive of your
computer, then you might want to group files that you plan to use (e.g., images,
videos, or other HTML documents) into folders. Similarly, you can make the
linking task easier by organizing the Web sites that you want to link to. Here is
one method for organizing Web sites of interest as Netscape bookmarks:

1 . Search and browse the Web adding interesting or relevant sites to your
list of bookmarks. To add a bookmark, choose "Add bookmark" from the
Netscape Navigator "bookmarks" menu when you are viewing a page that
is of interest).

2 . Once you have a good set of bookmarks, select the "Bookmarks" option
from the Netscape "Window" menu. You will now see a window showing
the current bookmarks. There will also be a new menubar at the top of the
screen. This is the Bookmarks menu.

3 . Use the "insert folder" option from the "Item" submenu of the
Bookmarks menu as many times as you want. You have now created a set
of folders that you can use to organize your bookmarks. Note that the
"Item" submenu is only available after you have selected the "Bookmarks"
option from the Netscape "Window" menu.

4 . Nest folders within other folders and drop bookmarks into folders to
create the bookmark hierarchy that you want. Note that this drag and drop
bookmark organization process is just like organizing your files into a
folder hierarchy in the Finder (System 7).

Note: Creating a link to a Netscape bookmark has the same effect as linking to the
Web page that the bookmark represents. Once you create the link, it is
represented by the URL for the web page (e.g., http://www.apple.com) and the
fact that you selected it as a bookmark is forgotten.
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Dragging Netscape Files from the Desktop

Sometimes it is more convenient to put together a whole set of URLs that you
will be linking to for a particular set of Web pages, then it is to grab URLs one at
a time from Web pages or bookmarks. You can create a set of URLs on the
desktop by dragging URLs or bookmarks out of Netscape NavigatorTM and on to
the desktop. These URL files can then be treated like desktop files and dragged
onto Tapestry pages. They can also be organized into folders so that they easier to
find and work with.

2.6 The Importance of Drag and Drop Linking

User interface design is a key factor in determining the usability of software and
how readily applications will be accepted by users. Drag and drop interaction is
direct manipulation at its best. The user deals with familiar objects directly in a
natural and intuitive way. Drag and drop interaction is also a central part of
"what you see is what you get" or WYSIWYG interfaces. Since drag and drop
interaction is easy to learn and efficient to use, it is a central component in user-
centered design, i.e., the design of users interfaces that match the needs and
capabilities of people as closely as possible.

Drag and drop linking is the easiest and best way to create HTML links. The
advantages of drag and drop interaction are:

1 . You can't make syntax errors

2 . You can't mis-type the directory path or file name.

3 . You are in direct control when specifying the link.

4 . You get continuous visual feedback on what is happening.

2.7 Testing a Link

If you want to test that the link is working in Tapestry, hold down the option key
and click on the link. This will take you to the document at the endpoint of the
link. If the link is to a local HTML or text document, the document specified by
the link will be shown as a Tapestry document. If you then want to return to the
document you came from, select “Back” from the "File" menu, click on the
"Back" button on the toolbar or type the Command-R shortcut.
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If you click on an external link, Tapestry will launch Netscape NavigatorTM with
the URL (Web document) specified by the external link. If Netscape is already
open, it will display the Web document corresponding to the link. If you click on
a link that points to a media file (e.g., a sound, video clip, or image), Tapestry
will launch the corresponding helper application and open up the appropriate
media file. You can create links to a wide variety of objects, including URLs,
HTML files on your hard disk, text files, images, videos, etc.

Note: Make sure that you set up the helper applications for Tapestry if you want
to test links to media files.

2. 8 Removing a Link

Move to the link that you want to remove and highlight it. Select "unlink" from
the “Special” menu (or click on the “unlink” button on the toolbar). Unlink then
removes any links contained in the highlighted text.

Feedback:  You should now see that the blue underline indicating the presence of
the link has been removed.

2. 9 Setting Helper Applications for Tapestry

In order to set a helper application:

1 .  Choose "preferences" from the “File” menu, and select the type of file
(e.g., image) that you are interested in from the list on the left of the
dialogue window.

2 .  Click on the "Choose" button corresponding to that file type. You will
then see a file selection dialogue.

3 .  Move to the directory where the corresponding helper application is
stored and select it.

Result: Tapestry will now remember your choice of helper application,
and it will be used to open that type of media file when you test links in the
future.

Most Tapestry users will probably only need the default set of helper applications
that are set in the default Tapestry preferences. However, you can add your own

©1996, Concept 1 Communications,  Inc.



Tapestry User’s Guide         Page-18 of 33

different types of application into the preferences dialogue. You should only
attempt this if you have a fairly good technical understanding of the Macintosh.
To do it, you choose the “Preferences” option in the “File” menu and then click
the “New” button in the resulting dialogue window. You will then be asked for
the MIME type and subtype information for the type of file that you are
interested in.

2. 10 Why Make Links to Other Web pages?

When you build your own Web pages, it is a good idea to pepper them with links
to other people's or organization's Web pages that you think are important or
useful. Don't worry about having to share the limelight. Here are some good
reasons for emphasizing links to other Web pages as part of your own Web page
design and implementation process.

1 . Creating good links to other sites and Web pages makes your own page
more attractive. People will start using your page as a "jumping off" point.
This means that they are more likely to visit your page regularly. They
may even add your page to their bookmark list.

2 . Good links add value to your page. The sites and pages that you choose
to link to, tell others about what you and your page are all about.

3 . Getting noticed is the name of the game when it comes to Web pages. If
you link to other pages, they are more likely to link to you. A page with no
links is a dead end, and that is "uncool".

4 . Links to important pages give your page an air of authority. If you're in
business, you may want to link to relevant Fortune 500 companies, and so
on.

2. 11 Embedding Links in Web Pages

Tip: A good link shouldn't just point to an interesting page, it should also be
embedded within appropriate content on your own page. Generally, links work
best when they are part of a natural flow of ideas within the page. Two common
ways of embedding links within the content of a page are to organize them in a
table of contents layout, or to embed them in paragraphs.
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3 Navigation

Navigation is the process of moving through information by pointing and clicking
on different options. It is often useful to navigate through your own Web pages as
you are constructing them. Tapestry has a built-in function that allows you to
navigate through documents, as explained in this section.

3.1 Following a Link

To follow a link:

Hold down the Option key and click on the link.

If the link is to a Local file then Tapestry will follow the Link.

If the Link is to a File on the Internet then the linked Web document
will be opened by Netscape NavigatorTM. See Section 3.3 below for
more information about testing links to pages on the Web (Internet).

3.2 Getting Back from a Link

Select "Back" from the "File" menu, click on the "Back" button on the toolbar or
type the Command-R shortcut.

Tapestry will now display the document from which you most recently traversed
a link.

Note: You can jump back and forth between two pages (documents) by
alternately pressing the "back" and "forth" buttons on the Tapestry toolbar.

3.3 Following a Link to a Web Page

You can test a link to a page on the Web the same way that you test a link to a file
on your hard drive, by option-clicking on the link. If the link you option-click on
is external and points to a Web page, then Tapestry will tell Netscape Navigator
to go to that page.

If Netscape Navigator is not open when the external link is option-clicked on,
then Netscape navigator will first open and then go to the page specified in the
link.
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Note: When you option-click on a local link, the document at the endpoint of the
link is loaded into the current Tapestry window.  If you have made any changes
since the last save, you will first be prompted to save the current version of the
page (document) you are on. In contrast, when you option-click on an external
link, the change occurs in Netscape Navigator, where the new page is shown.
Thus Tapestry doesn't prompt you to save the current page when you option-click
on (follow) an external link (e.g., to the Web).

Warning: It is all too easy to get sucked in to browsing the Web aimlessly when
you really should be building your own Web page. So it is generally best not to
browse the Web while you are trying to author a page. It is good practice to visit
the Web sites that you want to link to ahead of time, and organize them as
bookmarks. You can then link to the bookmarks, without the distraction of
browsing Web pages. See Section 2.5 for more information on how to create
links to Netscape bookmarks.

3.4 Following a Link to a non-HTML File

Click on a Tapestry link while holding the option key down (this operation is
commonly referred to as an "option-click") if you want to test or follow the link.

If the file requires a helper application, then that application will be launched and
the linked file will open within that application. For instance, clicking on a link to
an image might cause Tapestry to launch GraphicConverter, after which the
image file is opened within the GraphicConverter application.

Note: Launching a helper application will only work if that application has been
defined as the helper application for the particular document type (e.g.,
GraphicConverter has been set as the helper application for images). Refer to
Section 2.9 of this document for instructions on how to set helper applications in
Tapestry.

4 How to Edit

4.1 Inserting Text

Version 1.1 of Tapestry is like a simple text editor. You can type in text. You can
type in line breaks or paragraph breaks to add white space. You can remove text
by deleting back over it (with the delete key). You can also remove a large
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amount of text by highlighting it (dragging over it with the mouse button down)
and then hitting the delete key, or by using the Command-X key combination to
"cut" it. Alternatively, you can replace the highlighted text by typing new text
over it. In addition to using cut and paste, you can also move content material by
dragging it from one location and dropping it into another. To use this type of
internal drag and drop you:

1. Select/Highlight the material you want to move (as explained in the
following section).

2. Click on the highlighted segment and drag it to the new position you
want it to appear in.

4.2 Selecting/highlighting Text

To Select/Highlight a region of a document that contains text and/or images:

1 . Move the mouse pointer to the start of the region you want to highlight.

2 . Click and hold down the mouse button.

3 . Move the mouse pointer to the end of the region you want to mark.

4 . Release the mouse button.

Feedback: The region you selected should now be highlighted.

4.3 Copying

Copy to the clipboard by selecting a region (e.g., an image, or some text), and
then choosing Copy from the Edit menu (or else typing the Command-C
shortcut).

You can copy links within or between Tapestry documents as long as you make
sure that you select the entire link when you do the copy. When you have selected
the material to be copied, choose “Copy” from the Edit menu, or use the
Command-C combination. Links in Tapestry are indicated with blue underlines
(like this). When copying, make sure that you highlight the whole of the blue
underlined area, so that you include the link as part of the material being copied.
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You can also cut and paste images, links, and other multimedia elements within a
Tapestry document. You do this by selecting (or highlighting) a region of the
document, and then selecting cut, or paste from the Edit menu. You may also use
the Command-X (cut) and Command-V (paste) shortcuts. You can cut or copy
part of one Tapestry document and then paste it into another document.

Warning: There may be many links in one region. When copying, pasting, or
cutting, you should always make sure that you include complete links (i.e., the
whole of any underlined blue segments) in any selection.

4.4 Pasting

Click on a point in the document to select the insertion point. Then select “Paste”
from the Edit menu, or hit the Command-V shortcut. The most recently copied
material will be pasted into the document beginning at the insertion point that you
selected. If a region of text or other information is highlighted, the material
being pasted will replace it.

4.5 Cutting and Deleting

Select a region of text and then choose “Cut” from the Edit menu, or hit the
Command-X shortcut. You can also remove material by backing over it with the
delete key.

4.6 Copying and Pasting from other Applications

One of the easiest ways to get content material in to Tapestry is to copy and paste
it from other applications. For instance, you may want to grab some text from a
Word or ClarisWorks document. To do this:

1 . Highlight the text in the other application.

2 . Select "Copy" from the Edit menu (or by hitting the Command-C
combination).

3 . Go to the Tapestry document and choose an appropriate insertion point
(i.e., click the mouse on the position in the Tapestry document where you
want the copied text to be inserted).
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4 . Select "Paste" from the Edit menu, or hit the command-V key
combination.

5 . The material that you copied from the other application will now be
inserted into the Tapestry document.

Even easier, you can drag and drop material from other applications (this is
equivalent to a copy in one application followed by a paste in the other). This
works for some, but not all applications. For instance it works in SimpleText, but
not Microsoft Word (5.1). Generally, this type of drag and drop moving of
content will work well for those applications that are well integrated with the
Macintosh interface.

4.7 Alignment

The alignment menu contains options for aligning material to the left, centre, or
right. By default, lines are aligned to the left unless you specify otherwise.

Alignment occurs:

• by paragraph
• by selection

If you select an alignment option when nothing is highlighted (i.e., the cursor is
flashing in a single position), then the paragraph which the cursor is in is
realigned.

If you select an alignment option when a region is highlighted, then that whole
region is realigned. The region could be an image, a paragraph of text, a
combination of images and text, etc.

Note however that if a portion of any paragraph is highlighted when an alignment
operation is selected, then the whole of that paragraph will get realigned. This is
intended behaviour. Remember that the apparent length of lines within word-
wrapped text changes if the window is widened. So only paragraphs of text are
meaningful when choosing alignments.

Right Alignment

Select the text that you want to realign, and choose "right" from the Align menu
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(or click on the right align icon on the Toolbar).

Left Alignment

Select the text that you want to realign, and choose “left” from the Align menu
(or click on the left align icon on the Toolbar).

Centre Alignment

Select the text that you want to realign, and choose “centre” from the Align menu
(or click on the centre align icon on the Toolbar).

4.8 Setting Font Size

Tapestry font sizes vary between 9 points and 36 points.

To change the font size of a section of text, first highlight it, and then choose the
new font size from the size submenu.

4.9 Changing text styles

The basic styles in Tapestry Version 1.1 are plain, bold, and italic.

To change the text style you first select the text and then select the style option.
You can either do this by selecting an option from the pull down menu, the
toolbar, or else by using keyboard shortcuts (e.g., command-B for bold). Style
options are also available on the toolbar. If the selected text is unbolded, then
clicking on the "bold" button of the toolbar (abc) will change that text to
boldface. If the text is already bold, then clicking on the "bold" button of the
toolbar removes bold. Similarly, clicking on the "italic" button (abc) adds italics
to selected text if it isn't already in italic, but removes the italics otherwise. Bold
and italics can also be removed from text by clicking on the "plain text" option
under the Styles menu of Tapestry.

Removing Text Styles

Like most text processors, Tapestry treats bold and italics as toggles that can be
switched on and off. The easiest way to switch bold and italics on and off in
Tapestry, is to click the corresponding buttons on the toolbar. An alternative way
to switch bold and italics off to highlight the text and then select "plain" from the
Styles menu.
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Converting between text styles

The easiest way to switch between styles in Tapestry is to use the toolbar. For
instance, to change bold italicized text into bold (non-italic) text you do the
following:

1 . Highlight the text you want changed

2 . click on the "italics" button on the toolbar.

4.10 Setting the Background Colour

Tapestry lets you select a colour from a colour wheel. So you get to pick from a
huge range of colours and you get to preview your colour before you choose it.

To set the background colour:

1 .  Click on the background colour button on the tool bar.

2 .  After you click on the button, a colour wheel will be displayed.

3 .Move the cursor over the colour wheel until you find the colour that you
want. As well as the hue, you can also adjust the brightness and saturation
of the colour.

4 .Click on that  point and then click “OK” to end the dialogue.

5 .The new background colour is now displayed.

Note: If the colour wheel appears to be black, it's probably because the
brightness setting is to low. Move the slider or scroll bar until you can see the
different colours at the brightness that you want.

4.11 Setting the Foreground (Text) Colour

Choosing the foreground colour is very similar to choosing the background
colour. The main difference is that you highlight the text first before selecting the
colour from the colour wheel. Thus the steps for setting the text colour are:
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1 . Select/highlight the text that you want to change the colour of.

2 .  Click on the foreground colour button on the tool bar (this is the icon
with the coloured letters abc on it).

3 .  After you click on the button, a colour wheel will be displayed.

4 .Move the cursor over the colour wheel until you find the colour that you
want. As well as the hue, you can also adjust the brightness and saturation
of the colour.

5 .Click on that  point and then click “OK” to end the dialogue.

6 .The selected text is now shown in the colour that you chose.

Note that if you choose a new text colour without having any text highlighted,
then the text that you enter at the insertion point will have the new colour (e.g.,
red) that you selected from the colour wheel.

4.12 Inserting Paragraphs

Every time you hit the return key Tapestry puts a paragraph break into the
HTML document that is saved. Paragraphs can also be inserted explicitly using
the “New Paragraph” option under the “Special” menu.

4.13 Inserting Line Breaks

If you want a line break instead of a paragraph, hit shift-return (i.e., by holding
the shift key down while hitting the return key). If you look carefully, you will
notice that line breaks leave less space than paragraphs. Line breaks can also be
inserted explicitly using the “Line Break” option under the “Special” menu.

4.14 Inserting Horizontal Rules

You can insert a horizontal rule by hitting option-return (i.e., by holding the
option key down while hitting the return key). Horizontal rules can also be
inserted explicitly using the “Horizontal Rule” option under the “Special” menu.
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4.15 Document Title

Web pages should have document titles. These titles are particularly important
for search engines both in terms of searching for pages on different topics and in
terms of displaying the results of searches. Creating a good title for your
document makes it more likely that people who are interested in what you have to
say will be able to find your Web page.

To create or edit the document title for a Tapestry document, simply type in to
the text box that appears immediately below the Tapestry toolbar.

4.16 Exporting Text

If you want to create a text file that contains all the text in a Tapestry document
(but not the media elements or HTML markup), then choose the “Export Text”
option from the “File” menu. You will then see a save file dialogue where you
can name the file and choose where it will be stored in the file structure (i.e.,
which folder it will be put in).

5 Multiple language support

Tapestry is a multilingual product. Tapestry 1.1 includes English, German,
French, and Spanish localization. More languages will be added in future.

5.1 How do I switch to another language?

The default language of Tapestry is set either to the language of the country
where it is sold, or else to English. To switch to a different language, choose the
name of the desired language from the Language menu. Language options that
are grayed out indicate languages that are in the process of being added to
Tapestry.

5.2  Language Localization Features

Tapestry language localization includes localization of the balloon help, menus,
and various dialogues that appear while using Tapestry. In addition, Tapestry has
a feature where a brief description of each button in the toolbar is displayed when
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you move the mouse over that element. This toolbar help is also localized.

German, French, and Spanish versions of the Tapestry documentation are
currently under development and the versions of the documentation for those
languages supplied with Tapestry 1.1 are beta versions.

If you would like us to localize for another language not yet handled by Tapestry,
please contact us at support@concept1.com and let us know.

6 Media management

Tapestry was designed for efficient media management using drag and drop
interaction. You drag and drop video and sound clips into Tapestry documents in
the same way that you can drag and drop images.

6.1 Adding Images

To add an image to a Tapestry document, do the following:

1 . Locate the image file you want to add.

2 . Drag the file icon for the image onto the Tapestry document.

Note that the cursor insertion points moves as you move the image file icon
around the Tapestry document. Release the mouse button when the cursor
insertion point is in the desired location.

Result:The Image drops into the document at the selected location.

Warning: Make sure that the image is in JPEG or GIF format. If not, convert it
to one of those formats before dropping it into a Tapestry document. We
recommend that you use GraphicConverter (an inexpensive shareware product)
or a similar image conversion utility for this purpose.

If there is still a problem in adding the image, try closing a few windows that
don't have to be open. Make sure that you've allocated enough memory to the
Tapestry programme. Since image files can be quite large, you should be careful
that the memory requirements of the images you are using do no exceed the RAM
(memory) that is available..
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6.2 Resizing Images

To resize an image in Tapestry:

1. Click on the image. You will now see a selection region surrounding the
image (a gray rectangle with a highlight rectangle just outside it).

2. Click on the gray border around the image and drag the mouse to resize
it. Dragging the mouse in towards the center of the image will make the
image smaller, while dragging away from the image will make the image
larger.

a. If you grab the top or bottom of the gray rectangle you will
change the height of the image.

b. If you grab the left or right side of the gray rectangle you will
change the width of the image.

c. If you grab one of the four corners of the gray rectangle you can
change both the height and the width of the image at the same time.

Note: Once you start resizing the image you cannot automatically return to the
original size of the image. Those if you start resizing the image and then are
unhappy with the results it may be best to load in the original image again.

6.3 Setting the Background Image

The background image is set using the rightmost button on the toolbar. To set or
change the background image you simply drag and drop any JPEG or GIF file
onto the background image button on the toolbar. The image is then tiled to form
the background of the current document.

6.4 Removing or Replacing the Background Image

Click on the background image button on the toolbar to remove the current
background image. This results in the default of no background image. If you
want to replace the current background image with a different one, drag and
drop the JPEG or GIF file for the new image onto the background image button.
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6.5 Adding Video

To add a video clip to a Tapestry document, do the following:

1 . Locate the video file you want to add.

2 . Drag the file icon for the video clip onto the Tapestry document.

Result:The Video drops into the document at the selected location. The
first frame of the video will be shown, and you can click on the play button
on the controller below the video to play it back.

Warning: Make sure that the video is in QuickTime format.

6.6 Playing Back Video

Once you insert an in-line video in Tapestry you can preview it right away by
clicking on the play button on the controller that appears beneath the video clip.

If you want to play back embedded video in an HTML document using Netscape
NavigatorTM, make sure that you put the appropriate Quicktime video plug-in for
Netscape into the Netscape plug-ins folder on your disk. To play back the video
in Netscape simply click on the play button on the controller that is shown
beneath the inline video.

7 HTML markup

Web pages are written in HTML, the markup language of the World Wide Web.
When you create Tapestry documents they are saved as HTML, even though
Tapestry has been designed so that you can create Web pages without having to be
aware that they actually contain HTML.

HTML is actually a rapidly changing standard. In addition there are
“Netscapisms” which consist of markup that is not originally part of the HTML
standard (e.g., tables and frames) but which is popularized through its use with
the Netscape NavigatorTM browser.

Since Tapestry doesn’t handle all the possible HTML and Netscape tags, methods
are available to handle the additional “foreign tags” as explained later.
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7.1 Handling Foreign Tags

HTML documents are marked up as text files. If you open up an existing HTML
document, Tapestry displays the document according to the markup that it knows
about (e.g, Images are displayed, Links are activated, paragraphs are shown as
white space). Other markup is stored, so that it is retained when the file is saved.
Foreign tags that are not recognized by Tapestry are indicated by icons (with a
question mark on them) that are inserted in the appropriate position in the
document page as displayed in Tapestry. Double clicking on one of these icons
opens up a text dialog window where the text within the tag is displayed. This text
can then be edited. Thus you can view and edit HTML or “Netscapism” markup
that Tapestry doesn't yet handle.

Functions that are not native to Tapestry Version 1.1 include lists, forms, and
tables. These features will be added to future versions of Tapestry.

7.2 Adding Foreign Tags

Sometimes you may want to add tags that are not yet supported by Tapestry. Such
tags are referred to as “foreign tags”. To add a foreign tag, choose “foreign tag”
from the “Special” menu. A foreign tag icon (with the question mark on it) will
then be added at the position of the current insertion point (mouse pointer). You
can double click on the foreign tag to open up a text dialog window that can be
edited. Initially the window will be empty. Each tag that you type in should begin
with a begin-angle-bracket (“<“) and end with a close-angle-bracket (“>“).
Tapestry does not correct or validate the foreign tags that you create. Thus you
are responsible for making sure that you type in the correct syntax for the tag
that you want to create. If you are not careful in creating foreign tags you run the
risk of creating illegal HTML code which may prevent your pages from being
correctly loaded and presented on the Web.

Recommendation: You should always try out your pages in Netscape and make
sure that they are running correctly. This is particularly important when you
have edited or added foreign tags by hand.

7.3 Editing Foreign Tags

Editing a foreign tag is very similar to adding one. You simply click on the
corresponding foreign tag icon and then edit the resulting text dialogue.
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Warning:  Tapestry may occasionally have difficulty in correctly identifying
foreign tags when you open up a previously authored HTML document in
Tapestry. Future versions of Tapestry should experience few if any of these
problems. In Tapestry 1.1 you can add and remove problematic tags in the
HTML file (using a text editor) as necessary in order to load the HTML file
successfully. You can then insert any tags (using the foreign tag option on the
“Special” menu) that were removed from the file in order to get it to load into
Tapestry.

8 Building a Site

8.1 Checking for HTML Errors

Once you have your website formatted to your wishes, you need to collect all the
relevant files and send them to your Internet Service Provider.  Tapestry has an
option under the "File" menu called "Build Site" which organizes all the files for
you.  The "Build Site operation first checks your HTML coding for any
anomolies.  If it can, Tapestry will correct errors automatically. It will also check
for missing links.  If you have any missing links (errors) Tapestry will ask you if
you want to see them and if you choose "Show" it will display them in a Tapestry
window.

If you build your Web pages with Tapestry you will not have any errors
provided that you do not move files around your hard disk after you have created
links to them (otherwise they get “broken”).  However, it is possible for you to
include HTML from other sources (foreign tags) that is not correct or sometimes
there is a file which is part of the website but missing.  Tapestry will find all
these errors and display them to you. Tapestry 1.1 finds and corrects some
HTML errors, but is not guaranteed to find all HTML errors.

8.2 Choosing the Folder Location for the Site

When you have corrected any errors in your web site you can continue with the
build operation and watch as Tapestry collects all your files into a common
folder.  This folder name and location can be specified before the operation
begins.
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8.3 Uploading the Site

Once you have completed the "Build Site" operation you will be left with a folder
containing all the relevant files for your web site.  In this folder you will find a
HTML folder with all your HTML pages, an Images folder for you graphics (if
you have any), and “Video” and “Audio” folders for videos and sound files.
Other file types are assigned to the "Other" folder.  You are now ready to send
your files to your Internet Service Provider (ISP).  You can send your files by
either uploading (through the internet) your website folder to them or you can
deliver the files to them on disk.  The cost of maintaining your Website will be
different for each ISP and the cost of putting your web page up will vary from
one ISP to the next.

Visit our Web Site!

Visit our website at http://www.concept1.com for late breaking news on
Tapestry and related products.

Technical Support

Send email to support@concept1.com if you have a problem that requires
technical support. Before sending us email, please check the FAQs (frequently
asked questions) on the Concept 1 Website to make sure that you are not asking a
question that has already been answered in the FAQs.
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